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 Safety Guidelines 
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 
Danger 

indicates that death or severe personal injury will result if proper precautions are not taken. 

 
Warning 

indicates that death or severe personal injury may result if proper precautions are not taken. 

 
Caution 

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

 Caution 

without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

 Notice 

indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning and 
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes 
in this documentation qualified persons are defined as persons who are authorized to commission, ground and 
label devices, systems and circuits in accordance with established safety practices and standards. 

Prescribed Usage 
Note the following: 

 
Warning 

This device may only be used for the applications described in the catalog or the technical description and only in 
connection with devices or components from other manufacturers which have been approved or recommended by 
Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly 
as well as careful operation and maintenance. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Preface 1
1.1 General information 

Purpose of the Getting Started 
The Getting Started gives you a complete overview of the commissioning of the  
SM331 analog module (6ES7331-7KF02-0AB0). It assists you in the installation and 
configuration of the hardware of a thermocouple and the configuration of the analog module 
with SIMATIC S7 Manager. 
The intended readership of the Getting Started is a novice with only basic experience in the 
configuration, commissioning and servicing of automation systems. 

What to expect 
The procedures, from mounting the module to storing analog values in the STEP7 user 
program, are explained step-by-step and in detail based on an example. In the following 
sections you will be introduced to: 
● Problem analysis 
● Mechanical setup of the example station 
● Electrical connection of the example station 
● Configuration of the SIMATIC Manager 
● Creating a small user program with STEP7 which stores the read analog values in a data 

block 
● Triggering and interpreting diagnostic and hardware interrupts 
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Prerequisites 2
2.1 Basics 

Basic knowledge 
No special knowledge of the field of automation technology is required in order to understand 
the Getting Started guide. As the configuration of the analog module is done with the STEP7 
software, proficiency in STEP7 would be advantageous.  
Further information on STEP7 can be found in the electronic manuals that are supplied with 
STEP7. 
You will also need to know how to use computers or PC-like equipment (such as 
programming devices) under Windows 95/98/2000/NT or XP. 

Required hardware and software 
The scope of delivery of the analog module consists of 2 parts:  
● SM331 modules 
● Front connector for easy connection of the power supply and the data connections 
Analog module components  

 
Quantity Item Order no. 

1 SM 331, ISOLATED 8 AI, ALARM DIAGNOSTICS 6ES7331-7KF02-0AB0 
1 20-pin FRONT CONNECTOR with spring contacts 

Alternatively: 
20-pin FRONT CONNECTOR with screw contacts 

6ES7392-1BJ00-0AA0 
 
66ES7392-1AJ00-
0AA0 

1 SIMATIC S7 SHIELD CONNECTING ELEMENT 6ES7390-5AA00-0AA0
2 SIMATIC S7, TERMINAL ELEMENT F. 1 CABLE W. 4 TO 13 

MM DIA. 
6ES7390-5CA00-0AA0



Prerequisites  
2.1 Basics 

 SM331; AI 8 x 12 Bit Getting Started part 3: Thermocouples 
2-2 Getting Started, 11/2006, A5E00264193-02 

The general SIMATIC components required for the example are as follows: 
SIMATIC components of the example station 

 
Quantity Item Order no. 

1 PS 307 Power Supply AC 120/230V, DC 24V, 5A  
(incl. power supply bridge circuit) 

6ES7307-1EA00-0AA0

1 CPU 315-2 DP 6ES7315-2AG10-0AB0
1 MICRO MEMORY CARD, NFLASH, 128 KB 6ES7953-8LG00-0AA0
1 SIMATIC S7-300, RAIL L=530MM 6ES7390-1AF30-0AA0 
1 Programming device (PD) with MPI interface and MPI cable 

PC with suitable interface card 
depending on the 
configuration 

Installed software STEP7: 
 

Quantity Item Order no. 
1 STEP7 Software version 5.2 or later, installed on the 

programming device. 
6ES7810-4CC06-0YX0

You can use the following thermocouples for the acquisition of analog signals: 
 

Quantity Item Order no. 
2 Thermocouple type J depends on the 

manufacturer 
2 Thermocouple type K depends on the 

manufacturer 
1 Siemens compensating box (type J – 24 V DC) M72166-B4200 

 
 

 Note 
This "Getting Started" describes only the application of the thermocouples. If you wish to use 
other transducers, you will need to wire and configure the SM331 differently.  
Separate Getting Starteds are available for 4 - 20 mA current transducers, voltage 
transducers and the resistance thermometer PT100 standard, which can be connected to the 
SM331. 
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Furthermore, the following tools and materials are necessary: 
General tools and materials 

 
Quantity Item Order no. 
various M6-bolts and nuts (Length depending on the mounting position) commonly available 
1 Screwdriver with 3.5 mm blade commonly available 
1 Screwdriver with 4.5 mm blade commonly available 
1 Side cutter and cable stripper commonly available 
1 Crimp tool commonly available 
X m Wire for grounding the mounting rail with 10 mm2 cross-section, 

ring terminal with 6.5 mm hole, length appropriate for local 
requirements. 

commonly available 

X m  Flexible wire with 1mm2 diameter with fitting wire end sleeves, 
form A in 3 different colors – blue, red and green 

commonly available 

X m  3-wire power cord (AC 230/120V) with protective contact 
socket, length according to local conditions. 

commonly available 

1 Calibration device (measuring instrument for commissioning, 
that can measure and supply current) 

depends on the 
manufacturer 
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Task 3
3.1 Example of an application 

Overview 
The Getting Started leads you successfully through a sample application, in which you will 
install the following thermocouples: 
● Two thermocouples with type J and type K, which are directly installed on the analog 

module SM331 (using the internal reference junction) 
● Two equal thermocouples of type J, which are connected through an intermediate 

terminal (compensation point with external compensating box) 
You will activate failure diagnostics and hardware interrupts. You have the analog input 
module SM331, AI8x12 Bit (order number 6ES7 331-7KF02-0AB0) available. 
The module can process up to 8 analog inputs and trigger hardware and diagnostic 
interrupts. For each module, different measurement types can be set (e.g., current or voltage 
measurement, PT 100, thermocouple). 
The following mounting options are described in the sample task: 
● The thermocouples are installed close enough to the analog module and, therefore, the 

wires can be connected directly to the module. 
● The connection location of the thermocouples is further away from the analog module. 

In this case, the compensation wire is replaced by copper wires through a connection 
point. A compensating box has to be installed in the close vicinity of the connection point. 

 
Figure 3-1 Components of the example station 
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In the following sections you will be introduced to:  
● Mechanical setup of the example station 

– General mounting instructions for S7-300 modules 
– Configuration of the SM331 for the two selected measurement transducer types 

● Electrical connection of the example station 
– Wiring the power supply module and the CPU 
– Wiring of the analog module 
– Standard pin layout of the voltage transducer and resistance thermometer 

● Configuration of the SIMATIC Manager 
– Using the project wizard 
– Completing the automatically generated hardware configuration 
– Integrating the supplied user program source 

● Testing the user program 
– Interpreting the read values 
– Converting the measured values into readable analog values 

● Utilizing the diagnostic capabilities of the SM331 module 
– Triggering a diagnostic interrupt 
– Evaluating the diagnostics: 

● Application of hardware interrupts 
– Configuration of hardware interrupts 
– Configuration and analysis of hardware interrupts 

 

See also 
General (Page 5-1) 
Create a new project (Page 6-1) 
Downloading the system data and user program (Page 7-1) 
Reading diagnostic information from a PG (Page 8-1) 
Hardware interrupt (Page 9-1) 
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Mechanical setup of the example station 4
4.1 Mounting the example station 

Structure of the explanations 
The setup of the example station is divided into two steps. First, the setup of the power 
supply and the CPU is explained. After becoming acquainted with the analog module 
SM331, the mounting of it is described.  

Prerequisites 
Before you can use analog input module SM331, you need a basic setup of general 
SIMATIC S7-300 components. 
The order of the mounting takes place from left to right:  
● Power supply PS307 
● CPU 315-2 DP 
● Analog module SM331 



Mechanical setup of the example station  
4.1 Mounting the example station 

 SM331; AI 8 x 12 Bit Getting Started part 3: Thermocouples 
4-2 Getting Started, 11/2006, A5E00264193-02 

Procedure 
 

Step Graphic Description 
Screw on the mounting rail (screw size: M6) so that at 
least 40 mm space remains above and below the rail.  
When mounting it on a grounded steel panel or on a 
grounded device mounting panel made of steel sheet, 
make sure you have a low impedance connection 
between the mounting rail and the mounting surface.  

1 

 

Connect the rail to the protective conductor. An M6 screw 
is provided for this purpose on the rail. 

2 

 

Mounting the power supply:  
• Hang the power supply on to the top end of the rail 
•  
•  
•  
•  
•  
• Screw it tight to the rail underneath. 

3 

 

Connect the bus connector (delivered with the SM331) to 
the left connector on the back of the CPU  

4 

 

Mounting the CPU:  
• Hang the CPU on to the top end of the rail 
• Push it all the way left to the power supply 
• Push it down 
• Screw it tight to the rail underneath 
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4.2 Mounting of analog module components 

4.2.1 General 

Overview 
The measuring range modules should be plugged in accordingly before the mounting of 
SM331. 
In this section, you will learn about:  
● The components you need 
● The properties of the analog input module 
● What a measuring range module is and how it is configured 
● Mounting a configured module 
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4.2.2 Components of the SM331 

Overview 
A functional analog module consists of the following components: 
● Module SM331 (in our example 6ES7331-7KF02-0AB0) 
● 20-pin front connector There are two different types of front connectors: 

– With spring contacts (order number 6ES7392-1BJ00-0AA0) 
– With screw contacts (order number 6ES7392-1AJ00-0AA0) 

 
Figure 4-1 Components of the SM331 

The scope of delivery of SM331 
 

Components 
Analog module SM331 
Labeling strips 
Bus connectors 
2 cable ties (not in the picture) to tie the external wiring 
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4.2.3 Features of the analog modules 

Features 
The module is a universal analog module applicable to the most commonly used 
applications. 
The desired measuring mode should be set up directly on the module with the measuring 
range modules. 
● 8 inputs in 4 channel groups (each group with two inputs of same type) 
● Measurement resolution adjustable for each channel group 
● User defined measuring mode per channel group: 

– Voltage 
– Current 
– Resistance-type sensor 
– Temperature 

● Programmable diagnostic interrupt 
● Two channels with limit alarms (only channel 0 and channel 2 are configurable) 
● Electrically isolated against backplane bus 
● Electrically isolated against load voltage (exception: at least one module is set to position 

D) 

Alternatively applicable SM331; AI 8 x TC (only for thermocouples) 
If you install thermocouples solely, you can also use the analog module SM331; AI 8 x TC 
with the order number 6ES7331-7PF10-0AB0. Notes on connecting this device can be found 
in the "S7-300 Automation System, Module data" reference manual. 
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4.2.4 Measuring range modules 

Connection 
Module SM331 has 4 measuring range modules on it side (one measuring range module per 
channel group). You can set the measuring range modules to 4 different positions (A, B, C, 
or D). The position enables you to specify the transducer to be connected to the respective 
channel group.  

 
Figure 4-2 Measuring range modules with default setting B (Voltage) 

Possible positions of the measuring range modules 
 

Position Type of measurement 
A Thermocouple/resistance measurement 
B Voltage (factory setting) 
C Current (4-wire transducer) 
D Current (2-wire transducer) 

In our sample task we use the channel groups CH0, 1 and CH2, 3 in the measurement mode 
"Thermocouple". Verify that the measuring range modules are set to position A. If needed, 
adjust the desired position as described in the table below. 
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Positioning of the measuring range modules 
 

Step Graphic Description 
1 

 

With a screwdriver, pull out the two measuring range 
modules. 

2 

 

Turn the measuring range modules to the desired 
position. 

3 

 

Plug the measuring range modules back into the 
module. 
In our example, the module should have the following 
positions: 
CH0,1: A 
CH2,3: A 
 
 
 
 
CH4,5: B 
CH6,7: B 
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4.2.5 Mounting the SM331 module 

Procedure 
After you have prepared the analog module accordingly, mount it to the rail as well. 

 
Step Graphic Description 
1 

 
 

Mounting the SM331: 
• Hang the SM311 to the top end of 

the rail 
• Push it all the way to the left up to 

the CPU 
• Push it down 
• Screw it tight to the rail underneath 

2 

 

Mounting the front connector:  
• Press the upper release button of 

the front connector. 
• Insert the front connector into the 

module until it snaps in 

The example station is now mechanically mounted. 
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Electrical connection of the example station 5
5.1 General 

Overview 
This chapter describes how the various parts of the example station are electrically wired 
from the power supply to the analog module. 

 

 
Warning 
You might get an electrical shock if the power supply PS307 is turned on or the power cord 
is connected to the line.  
Always switch off power before you start wiring the S7-300. 
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5.2 Wiring the power supply module and the CPU 

Overview 

 
Figure 5-1 Wiring the power supply module and the CPU 
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The example station requires a power supply. The wiring is done as follows: 
Wiring the Power Supply and the CPU 

 
Step Graphic Description 
1  Open the front panel covers of the power supply module 

and CPU. 
2  Unscrew the cable grip on the power supply. 
3 Remove the insulation from the power cord, attach the cable 

end sleeves (for stranded wires) and connect it to the power 
supply. 

4 Screw the strain-relief assembly tight. 

5 

 

Insert two connecting cables between the power supply and 
the CPU and tighten them. 
Do not modify the grounding switch, as the SM331 is 
already set up to be isolated. 
Information about the CPU's grounding switch: 
• Pressed: Electrically isolated (as-delivered state) 
• Pulled: Isolated 

6 Check that the line voltage selector switch is set to the 
correct line voltage. Mains voltage  
The default line voltage setting for the power supply module 
is 230 VAC. To label a front connector, follow the steps 
outlined below: Remove the protective cap with a 
screwdriver, set the switch to the required line voltage and 
replace the protective cap.  
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5.3 Connection variations of the analog module 

5.3.1 General 

Overview 
For the connection of thermocouples the wiring of the analog module SM331 differs only 
through the selection of: 
● Usage of the internal reference junction 
● Usage of an external reference junction 
In the following chapters you will be led through the two types of connection with internal and 
external reference junction. 

5.3.2 Shielded wires for analog signals 

Wires 
You should use shielded and twisted-pair wires for analog signals. This reduces the effect of 
interference. You should ground the shield of the analog wires at both ends of the wire. 
If there are differences in potential between the ends of the wires, equipotential current may 
flow across the shield, which could disturb the analog signals. In this case, you should either 
ground the shield at only one end or install an appropriate compensation wire. 
Usage of the internal and external reference junction 

 
Property Usage of an internal reference 

junction 
Usage of an external reference 
junction 

Wiring with thermocouples of 
the same type 

A maximum of 8 thermocouples 
is possible. 

A maximum of 8 thermocouples 
is possible. 

Wiring with a combination of 
different thermocouple types 

For each channel group 2 
thermocouples of the same type 
can be installed. 
This means that: A total of 8 
thermocouples with maximum 4 
different types can be installed. 

A combination of different 
thermocouples is not possible. 
All channels of the module refer 
to the same reference junction. 
Therefore, a maximum of 8 
thermocouples of the same type 
can be installed. 

Usable connection wires Direct connection of the 
thermocouples 
Connection through 
compensation wires 

Long copper wires are possible. 
Connection of the 
thermocouples directly at the 
reference junction. 
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5.3.3 Connection diagram of thermocouples with internal reference junction 

Overview 
The following figure shows analog module SM331 with thermocouples connected via a 
compensation wire and internal reference junction. 

 
Figure 5-2 Connection diagram: Usage of the internal reference junction 

The compensation wire always has to be the same material (alloy) as the thermocouple 
itself. 
On a channel group, only thermocouples of the same type can be installed. 
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5.3.4 Connection diagram of an analog module with internal reference junction 

Overview 
The wiring of the analog module consists of the following tasks: 
● Connecting the power supply (red cable) 
● Connecting the compensation wires for the thermocouples 
● Short-circuiting the reference junction 
● Connecting to ground and short-circuiting the other unused channels (blue cables) 
Details of the wiring are explained in the next chapter. 

 
Figure 5-3 SM331 Front connector wiring 
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5.3.5 Wiring of the analog module with internal reference junction 

Procedure 
Wire the thermocouples either directly to the inputs of the module, or indirectly via 
compensation wires. The following table describes the wiring step-by-step: 
SM331 Front connector wiring 

 
Step Graphic wiring Comments 

1  Open the front door of the SM331 The connection diagram is 
printed on the front flap. 

2  Remove 6 mm of the insulation from the ends 
of the wires that go into the front connector. 
Attach cable end sleeves to these ends.  

 

3 Wire the front connector as follows: 
Terminal 1: L+ 

power supply of the 
module  

4 Terminal 2: M+ First thermocouple type J 
Terminal 3: M- First thermocouple type J 
Terminal 4: M+ Second thermocouple type J 
Terminal 5: M- Second thermocouple type J 
Terminal 6: M+ First thermocouple type K 
Terminal 7: M- First thermocouple type K 
Terminal 8: M+ Second thermocouple type K 
Terminal 9: M- Second thermocouple type K 

Standard wiring for 
thermocouples with internal 
reference junctions. 
If you swap M+ and M-, the 
measurement values obtained 
will be incorrect and will not 
correspond to the real 
temperature! 

5 Terminal 10: (Comp+) and  
Terminal 11: (Comp-) 

Thermocouples that are 
connected directly or via 
compensation wires do not 
need an external reference 
junction.  
The external reference junction 
is short-circuited via the bridge.

6 Short-circuit terminal 11: ( Mana ) and 
terminal 12 to 19 and connect with  
terminal 20: M. 

Unused channel groups should 
be short-circuited with Mana 
(Comp-) and M in order to 
achieve a maximum 
interference resistance. 
Note: 
Terminal 11 Mana is called 
Comp- when used with an 
external cold junction. 
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5.3.6 Connection diagram of thermocouples with external reference junction 

Overview 
The diagram illustrates the analog module SM331 with connection 
● Of thermocouples over a connection point for compensation wire 
● Of an external reference junction 

 
Figure 5-4 Wiring: Thermocouple with external reference junction 

In the case of external compensation, the temperature of the reference junction for the 
thermocouple is acquired by means of a compensating box. 
The compensating box contains a bridge circuit that is adjusted for a certain reference 
temperature (compensating temperature). 
The thermocouple-compensation-wire should be connected in the immediate vicinity of the 
compensating box. Only then can you guarantee that the surrounding temperature of the 
connection point of the thermocouple and the compensating box is the same. 
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5.3.7 Connection diagram of an analog module with external reference junction 

Overview 
The wiring of the analog module consists of the following tasks: 
● Connecting the power supply (red cable) 
● Connecting the compensation wires for the thermocouples 
● Connecting the reference junction 
● Connecting to ground and short-circuiting the other unused channels (blue cables) 
Details of the wiring are explained in the relevant chapter. 

 
Figure 5-5 SM331 Front connector wiring 
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See also 
Wiring of the analog module with external reference junction (Page 5-11) 
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5.3.8 Wiring of the analog module with external reference junction 

Procedure 
Install the thermocouple over a compensation point. From this terminal on, copper wires are 
used all the way to the inputs of module SM331. The required wiring tasks are explained 
below step-by-step: 
SM331 Front connector wiring 

 
Step Graphic wiring Comments 
1  Open the front door of the SM331 The connection diagram is 

printed on the front flap 
2  Remove 6 mm of the insulation from the ends of 

the wires that go into the front connector. Attach 
cable end sleeves to these ends.  

 

3 Wire the front connector as follows: 
Terminal 1: L+ 

L+ from the power supply of the 
module 

4 Terminal 2: M+ First thermocouple type J 
Terminal 3: M- First thermocouple type J 
Terminal 4: M+ Second thermocouple type J 
Terminal 5: M- Second thermocouple type J 
Terminal 6: M+ Third thermocouple type J 
Terminal 7: M- Third thermocouple type J 
Terminal 8: M+ Fourth thermocouple type J 
Terminal 9: M- Fourth thermocouple type J 

Standard wiring for 
thermocouples with external 
reference junctions. 
If you swap M+ and M-, the 
measurement values obtained 
will be incorrect and will not 
correspond to the real 
temperature! 

5 Connect terminal 10: (Comp+) and  
terminal 11: (Comp-) with the compensating 
box. 

For the wiring of the 
compensating box, 
see the relevant chapter 

6 Short-circuit terminals 12 to 19 and connect 
with terminal 20. 
 
 
 
 
Terminal 20: M 

Unused channel groups should 
be short-circuited with M in order 
to achieve a maximum 
interference resistance. 
 
M from the power supply of the 
module 
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5.3.9 Wiring of the external reference junction 

Procedure 
In our example we use a Siemens compensating box for thermocouple type J (MLFB 
M72166-B4200) with 24 V DC as auxiliary power. The compensating box should be mounted 
in the direct vicinity of the connection point. 

 

1 2

3

45  
Figure 5-6 Connection point 

 
(1) Copper wires to module SM331 
(2) Auxiliary power 24 V DC 
(3) Compensating box 
(4) Connection of the reference junction 
(5) Compensation wires of thermocouple 
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Wiring of the compensating box 
 
Graphic wiring Comments 

 
 

Wire the compensating box as follows: 
Terminal 1: M Auxiliary power 24 V DC 
Terminal 3: L+ Auxiliary power 24 V DC 
Short-circuit terminals 11 and 12 (green cable). 
Connect terminal 8 with terminal 11 (Comp-) of 
the SM331. 
Connect terminal 9 with terminal 10 (Comp+) of 
the SM331. 

 
 
 
 
 
The reference temperature of 0°C that is 
required by SM331 is reached by short-
circuiting terminals 11 and 12.  
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5.3.10 Check the wiring 

Introduction 
If you want to test the wiring, you may now switch the power supply on. 
Do not forget to set the CPU to STOP (see the red circle). 

 
Figure 5-7 Successful wiring, CPU in position STOP 

If a red LED is lit, then there is an error in the wiring. Verify your wiring.  
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Configuration of the SIMATIC Manager 6
6.1 Creating a new STEP7 project 

6.1.1 Create a new project 

Overview 
In this chapter you will be guided through the following tasks: 
● Creating a new STEP7 project 
● Parameterization of the hardware configuration 

Wizard "New Project..." 
Use STEP7 V5.2 or later for configuring the new CPU 315-2 DP. 
Start SIMATIC Manager by clicking the "SIMATIC Manager" icon on your Windows Desktop 
and create a new project with the STEP7 "New Project" wizard. 

 
Figure 6-1 Starting the "New Project..." wizard 
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A project wizard introduction window appears. The wizard guides you through the procedure 
for creating a new project. 

 
Figure 6-2 Wizard "New Project", start 

The following must be specified during the creation procedure: 
● The CPU type 
● The basic user program 
● The organization blocks 
● Project name 
Click "Next." 
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6.1.2 CPU selection 

Procedure 
Choose the CPU 315-2DP for the example project. (You can also use our example for a 
different CPU. Select the appropriate CPU in this case.) 

 
Figure 6-3 "New Project" wizard: Selecting a CPU 

Click "Next". 
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6.1.3 Defining the basic user program 

Procedure 
Choose the SIMATIC language STL and select the following organization blocks (OBs): 
● OB1 cyclically executed block 
● OB40 hardware interrupt 
● OB82 diagnostic interrupt 
OB1 is required in every project and is called cyclically.  
OB40 is called when a hardware interrupt occurs. 
OB 82 is called when a diagnostic interrupt occurs. 

 
Figure 6-4 From part 1, "New Project" wizard: Inserting organization blocks 

Click "Next." 
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6.1.4 Assigning the project name 

Procedure 
Select the "Project name" text box and overwrite the name it contains with "Getting Started 
S7 SM331". 

 
Figure 6-5 From part 1, "New Project" wizard: Naming the project 

Click "Finish". The basic STEP7 project is created automatically. 
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6.1.5 Result S7 project is created 

Result 
The wizard has created the project “Getting Started S7-SM331”. You can see the inserted 
organization blocks in the right window. 

 
Figure 6-6 "New Project" wizard results 
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6.2 Hardware configuration 

6.2.1 Creating the hardware configuration 

Overview 
The STEP7 wizard has created a basic S7 project. You also need a complete hardware 
configuration in order to create the system data for the CPU. 

Procedure 
You can create the hardware configuration of the example station with SIMATIC Manager. . 
To do this, select the folder "SIMATIC 300 Station" in the left window. Start the hardware 
configuration by double-clicking the folder "Hardware" in the right window. .. 

 
Figure 6-7 Opening the hardware configuration 
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6.2.2 Adding SIMATIC components 

Procedure 
First select a power supply module from the hardware catalog.  
If the hardware catalog is not visible, open it with the shortcut key Ctrl+K or by clicking the 
catalog icon (blue arrow).  
In the hardware catalog you can browse through the folder SIMATIC 300 to the folder PS-
300. 
Select the PS307 5A and drag it into slot 1 (see red arrow). 

 
Figure 6-8 Hardware configuration: Basic configuration 

Result: PS 307 5A appears in the configuration of your rack. 
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Inserting an analog module 
There are many SM331 analog modules. For this project we use an SM331, AI8x12 bit with 
the order number 6ES7 331-7KF02-0AB0.  
The order number is displayed at the bottom of the hardware catalog (see blue arrow). 
Select the SM331 AI8x12bit from the right window and drag it onto the first free field in slot 4 
(see red arrow) in the configuration table.  
You have inserted all the modules into the hardware configuration table. In the next step, you 
configure the modules. SIMATIC Manager inserts the analog module with its default settings. 
You can modify the parameters to change the sensor types, diagnostics and interrupt 
capabilities. 

 
Figure 6-9 Hardware configuration: SM331 insert 
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6.2.3 Parameterization of the analog module of the example station 

Overview 
You can modify the parameters to change the sensor types, diagnostics and interrupt 
capabilities.  
To open the parameterization, double-click the analog module in the configuration table. The 
Properties view of the SM331 opens. 

Overview of the functionalities with internal compensation 
The table shows the parameters that have to be set with internal compensation. 
SM331 functionalities of the example station with internal compensation 

 
Functionalities Description Remark 
Process 
reactions 

Diagnostics – enabled 
Hardware interrupt when limit exceeded - 
enabled 

 

Encoder 1 Thermocouple type J  Channel group (input) 0 - 1 
Encoder 2  Thermocouple type J Channel group (input) 0 - 1 
Encoder 3 Thermocouple type K Channel group (input) 2 -3 
Encoder 4 Thermocouple type K Channel group (input) 2 -3 
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Parameterization of the SM331 with internal compensation 
If you want to parameterize the SM331 for internal compensation, please set the module as 
follows: 

 
Figure 6-10 SM331: Parameterization of thermocouple with internal reference junction 

Overview of the functionalities with external compensation 
The table shows the parameters that you have to set with internal compensation. 
SM331 functionalities of the example station with external compensation 

 
Functionalities Description Remark 
Process 
reactions 

Diagnostics – enabled 
Hardware interrupt when limit exceeded 
- enabled 

 

Encoder 1 Thermocouple type J  Channel group (input) 0 - 1 
Encoder 2  Thermocouple type J Channel group (input) 0 - 1 
Encoder 3 Thermocouple type J Channel group (input) 2 -3 
Encoder 4 Thermocouple type J Channel group (input) 2 -3 
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Parameter window with external compensation 
If you want to use a compensating box, please set the module as follows: 

 
Figure 6-11 SM331: Parameterization of thermocouple with external reference junction 
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6.2.4 Explanation of the settings of the SM331 

Attitudes 
The SM331 setting options are explained below. 
Diagnostic interrupt  
When the diagnostic interrupt is activated, the diagnostic OB82 is called if the grounding or 
the power supply is lacking. 
Hardware interrupt when limit exceeded 
If the parameter "Hardware interrupt when limit exceeded" is activated, hardware interrupt 
OB40 is called when the set limit values are exceeded or undershot. 
Only the channels (inputs) 0 and 2 have hardware-interrupt capabilities. No other inputs can 
trigger hardware interrupts. 
The limit values can be set in the same window under "Trigger for Hardware Interrupt". 
Group diagnostics 
If Group diagnostics is selected, channel-specific diagnostic messages are activated. When 
a diagnostic event occurs, OB82 is called. 
Wire break monitoring 
When wire break monitoring is activated, wire breaks will be diagnosed. OB82 is called. 
Type of measurement 
TC-IL: Thermocouple with internal reference junction 
TC-EL: Thermocouple with external reference junction 
Measurement range 
Specification of the thermocouple type 
Position of the Coding Key 
The required setting of the measuring range module is displayed. 
Interference frequency (Interference frequency suppression)  
The interference frequency is set to your local power line frequency. 
Finish the hardware configuration 
Close the window with the configuration. 
Compile and save the project with the command "Station > Save and Compile" (Ctrl+S). 
This completes your hardware configuration for the project. 

See also 
Channel dependent diagnostic messages (Page 8-4) 
Measuring range modules (Page 4-6) 
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6.2.5 Power up test 

Procedure 
For testing, do a power up test and download the system data. 

Powering-up 
 

Steps Graphic Description 
1 

 

Erase your Micro Memory Card with a Power PG 
or a PC with external programming device: :  
In SIMATIC Manager click "File -> S7 Memory 
Card > Delete …". 
The MCC will be deleted. 

2 

 

Switch off the power supply to the CPU. 
Insert the MMC into the CPU. 
Switch on the power supply. 

3 

 

Set the CPU from "RUN" mode to "STOP" mode. 

4 

 

Switch the power supply on again. 
If the STOP LED blinks, the CPU requests a 
reset. . Acknowledge this by turning the mode 
switch to MRES for a moment.  

5 

 

Connect the CPU to the PG with an MPI cable. .  
To do this, connect the MPI cable with the CPU’s 
MPI port. Connect the other end to the PG 
interface of your programming device. 
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Downloading hardware configuration 
Download the hardware configuration into the CPU with HW Config. 

 
Figure 6-12 Downloading the CPU hardware configuration (1) 
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Click the "Load to module" icon (shown in the red circle).  
When the dialog window "Select target module" appears, click OK. 

 
Figure 6-13 Downloading the CPU hardware configuration (2) 

The dialog window "Select target address" is shown. Click "OK." The system data will now 
be transferred to the CPU.  
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Starting the CPU 
Switch the CPU to RUN. 
If the hardware configuration was undertaken correctly, two green LEDs (RUN and DC5V) 
should be lit on the CPU. 

 
Figure 6-14 CPU in error-free state 

If the RUN LED light is not lit, then there is an error. 
In order to locate the error, read the diagnostic buffer with a PG. Possible causes of error: 
● The wiring has been done incorrectly 
● The coding device has been plugged in incorrectly 
● You have entered the parameters of the SM331 incorrectly. 
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6.3 STEP 7 user program 

6.3.1 Tasks of the user program 

Overview 
The example user program 
● Stores the sensor values in a data block and 
● Saves the status information of the hardware interrupts in a marker word. 
The status information is acknowledged by means of a bit. Furthermore, the channel values 
(values of the input words) are stored in another data block. 
The following tasks have to be performed in the user program: 
1. Cyclical storage of the analog input values in a data block (DB1) 
2. Cyclical conversion of the sensor values into floating point values (FC1) and storage in a 

data block (DB2) 
3. Acknowledgement of the hardware interrupt status when the acknowledge marker 

(M200.0) is TRUE 
4. Saving of the status in a marker word (MW100) when a hardware interrupt occurs 
Structure of the user program 

 
Call type Responsible 

organization block 
Task to be programmed Used block or marker 

Save analog input 
values 

DB1 

Convert and store the 
sensor values 

FC1, DB2 

Cyclic 
execution 

OB1 

Acknowledge hardware 
interrupt 

M200.0 

Execution 
triggered by 
hardware 
interrupt 

OB40 Save status MW100 

Execution 
triggered by 
diagnostic 
interrupt 

OB82 Has to be implemented 
because a module with 
diagnostic capabilities 
is used. 

--- 

Diagnostic interrupt OB82 
In the STEP7 program, OB82 is used for modules with diagnostic capabilities. 
If the module detects a failure (incoming and outgoing events), the module sends a request 
to the CPU for diagnostics. The operating system then calls OB 82. 
In our example, we use OB82 to prevent the CPU from changing to STOP mode. You can 
program reactions to diagnostic interrupts in OB82. 
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6.3.2 Creating a user program 

Procedure 
There are two ways to create a user program: 
● If you know how to program STEP7 SCL, then you can create and program the 

necessary blocks and the function blocks in the Blocks folder of STEP7. 
● You can insert the user program from an SCL source into the project. In this “Getting 

started” we describe this method. 
Creating a user program in STEP7 requires three steps: 
1. Downloading the source file directly from the HTML page 
2. Importing a source file 
3. Compiling the source 

Downloading the source file 
You can download the source file directly from the HTML page from which you loaded this 
“Getting Started”. Click "Info" and the download window will be opened. 
● Note the name of the source file. 
● Save the source file to your hard drive. 
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Importing a source file 
You can import the source file into SIMATIC Manager as follows: 
1. Right-click the folder "Sources". 
2. Select "Insert New Object > External Source...". 

 
Figure 6-15 Importing an external source 



 Configuration of the SIMATIC Manager 
 6.3 STEP  7 user program 

SM331; AI 8 x 12 Bit Getting Started part 3: Thermocouples 
Getting Started, 11/2006, A5E00264193-02 6-21 

In the "Insert external source" dialog, browse for the source file GSSM331T1DE.AWL, which 
you have already downloaded and saved on your hard disk. 
Select the source file GSSM331T1DE.AWL (red arrow). 

 
Figure 6-16 Importing an external source 
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Click "Open". 
SIMATIC Manager has opened the source file. In the right window you can see the source 
file inserted. 

 
Figure 6-17 Compiling the source code 
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Compiling the source code 
In order to create an executable STEP7 program, the STL source has to be compiled. 
Double-click the source file GSSM331T1DE in the Sources folder. The source code editor 
opens. 
In the window of the source code editor you can view the source code. 

 
Figure 6-18 Source code editor 
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After the source code is loaded, start the compilation. 
Press the shortcut key Ctrl+K or select "File > Compile". The compilation starts immediately. 

 
Figure 6-19 Compiling STL source 

In case of warning or error messages, check the source code.  
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Figure 6-20 Source code editor, messages after compilation 
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Close the source editor. 
After compiling the STL source without errors the following blocks should appear in the 
Blocks folder: 
OB1, OB40, OB82, FC1, DB1 and DB2 

 
Figure 6-21 Generated blocks 
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Testing the user program 7
7.1 Downloading the system data and user program 

Procedure 
The hardware and software are now ready. The next step is to download the system data 
and the user program into the automation system. To do this, proceed as follows: 
Downloading the system data and user program 

 
Step Graphic Description 
1 Using the SIMATIC Manager, download the 

user program and the system data (containing 
the hardware configuration) into the CPU. 

2 

 

Follow the instructions displayed on the 
screen. 
If all sensors are properly connected, the CPU 
and the SM331 do not display an error light.  
The status of the CPU is displayed by the 
green "RUN" light. 
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Smart Label 
The labeling strips for the modules were created with Siemens S7 Smart Label (order no: 
2XV9 450-1SL01-0YX0). 
A labeling strip in its actual size: 

 
Figure 7-1 S7-SmartLabel labeling strip for the example 
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7.2 Visualization of the sensor values 

Procedure 
In order to visualize the sensor values, insert a variable table as follows into the project. To 
do this, select from the context menu of the Blocks folder: : 
"Insert New Object > Variable Table" 

 
Figure 7-2 Insert Variable Table 
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Complete the new variable table as follows: 

 
Figure 7-3 Control_Display variable table 

 
(1) In this area you can monitor the channel values 
(2) In this area you can monitor and control the status signals. 
(3) In this area you can see the analog values 
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Monitoring values 
In order to monitor values, open the online view of the controller by clicking the eye glasses 
symbol. Now you can monitor the values in the data blocks and markers. 

 
Figure 7-4 Online view of the variable table 
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Controlling values 
To control the process acknowledgement, enter the desired value ("TRUE" or "FALSE", 
depending on whether you want to activate or deactivate acknowledgement) into the column 
"Control Value" and click the icon with the two arrows: 

 
Figure 7-5 Controlling tags 

Peculiarity in monitoring the values 
While monitoring the values you will surely notice that the channel values are different from 
the analog values. The reason for this is that the analog module only supports the binary 
format “Word” (16 bits). Therefore, the values of the analog module have to be converted. 
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7.3 Analog-value representation of the thermocouple 

Overview 
Analog input modules convert the analog process signal into a digital format (16-bit word). If 
you want to display the analog process values, then the digital values of the module should 
be converted to decimal values. 
In our example program, the process values are shown in the readable format °F. The 
conversion of the digital values into decimal values is realized in the programmed function 
FC1. 
In the following tables you will find information on the temperature range and digital values 
(display in hexadecimal) of the thermocouple that are created by the module: 
● Type E 
● Type J 
● Type K 
● Type L 

Representation of Analog Values for Thermocouples Type E 
 

Analog-value 
representation 

Temperature Scope Remark 

32767 7FFF > 2,192.00°F Overflow From hex value 16#2E01 on, the sensor 
value is above the configured measurement 
value range and is no longer valid. 

12000 2E00 2,192.00°F 
... ... ... 
10001 2711 1,832.18°F 

Overload range This range corresponds to a tolerance band 
before the overflow range is reached. Within 
this range the resolution is not optimal 
though. 

10000 2710 1,832.00°F 
… … … 
… … … 
-2700 F574 -454.00°F 

Rated range The nominal range is the normal range for 
recording measurement values. This range 
guarantees optimal resolution. 

< -2700 <F574 < -454.00°F Underflow If the wiring is wrong (e.g., swapped wires 
or open circuited inputs) or a sensor error 
occurs in a negative range (e.g., wrong 
thermocouple type), the analog module will 
report an underflow for values lower than 
16#F0C4 and the output will be 16#8000. 
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Representation of Analog Values for Thermocouples Type J 
 

Decimal Hexadec
imal 

Temperature Scope Remark 

32767 7FFF > 2,642.00°F Overflow From hex value 16#38A5 on, the sensor 
value is above the configured 
measurement value range and is no longer 
valid. 

14500 38A4 2,642.00°F 
... ... ... 
12010 2EEA 2,193.80°F 

Overload range This range corresponds to a tolerance 
band before the overflow range is reached. 
Within this range the resolution is not 
optimal though. 

12000 2EE0 2,192.00°F 
… … … 
… … … 
-2100 F7CC -346.00°F 

Rated range The nominal range is the normal range for 
recording measurement values. This range 
guarantees optimal resolution. 

< -210 <F7CC < -346.00°F Underflow If the wiring is wrong (e.g., swapped wires 
or open circuited inputs) or a sensor error 
occurs in a negative range (e.g., wrong 
thermocouple type), the analog module will 
report an underflow for values lower than 
16#F31C and the output will be 16#8000. 

Representation of Analog Values for Thermocouple Type K 
 

Decimal Hexadec
imal 

Temperature Scope Remark 

32767 7FFF > 2,951.60°F Overflow From hex value 16#3F5D on, the sensor 
value is above the configured 
measurement value range and is no longer 
valid. 

16220 3F5C 2,642.00°F 
... ... ... 
13730 35A2 2,503.40°F 

Overload range This range corresponds to a tolerance 
band before the overflow range is reached. 
Within this range the resolution is not 
optimal though. 

13720 3598 2,501.60°F 
… … … 
… … … 
-2700 F574 -454.00 °F 

Rated range The nominal range is the normal range for 
recording measurement values. This range 
guarantees optimal resolution. 

< -2700 <F574 < -454.00 °F Underflow If the wiring is wrong (e.g., swapped wires 
or open circuited inputs) or a sensor error 
occurs in a negative range (e.g., wrong 
thermocouple type), the analog module will 
report an underflow for values lower than 
16#F0C4 and the output will be 16#8000. 
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Representation of Analog Values for Thermocouple Type L 
 

Decimal Hexadec
imal 

Temperature range Remark 

32767 7FFF > 2,102.00°F Overflow From hex value 16#2CED on, the sensor 
value is above the configured 
measurement value range and is no longer 
valid. 

11500 2CEC 2,102.00°F 
... ... ... 
9010 2332 1,653.80°F 

Overload range This range corresponds to a tolerance 
band before the overflow range is reached. 
Within this range the resolution is not 
optimal though. 

9000 2328 1,652.00°F 
… … … 
… … … 
-2000 F830 -328.00 °F 

Rated range The nominal range is the normal range for 
recording measurement values. This range 
guarantees optimal resolution. 

< -2000 <F830 < -328.00°F Underflow If the wiring is wrong (e.g., swapped wires 
or open circuited inputs) or a sensor error 
occurs in a negative range (e.g., wrong 
thermocouple type), the analog module will 
report an underflow for values lower than 
16#F380 and the output will be 16#8000. 

 



Testing the user program  
7.3 Analog-value representation of the thermocouple 

 SM331; AI 8 x 12 Bit Getting Started part 3: Thermocouples 
7-10 Getting Started, 11/2006, A5E00264193-02 



 

SM331; AI 8 x 12 Bit Getting Started part 3: Thermocouples 
Getting Started, 11/2006, A5E00264193-02 8-1 

Diagnostic interrupt 8
8.1 Reading diagnostic information from a PG 

Overview 
Diagnostic interrupts enable the user program to react to hardware errors. 
Modules must have diagnostic capabilities in order to generate diagnostic interrupts. 
In OB82 you program the reaction to diagnostic interrupts. 

Diagnostic-interrupt display 
The analog input module SM331 AI8x12bit has diagnostic capabilities. 
Diagnostic interrupts that occur are signaled by the red "SF" LED on the SM331 and on the 
CPU. 
Generation of a hardware error 

 
Graphic Description 

 
 

Release the power supply 
wire from terminal 1. 
Result: A diagnostic interrupt 
has been triggered. 
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The cause of the error can be determined "online" by requesting the hardware status. 
In order to determine the state of module "online", proceed as follows. 
1. Select the SM331 in the hardware configuration. 
2. Click the menu item "PLC > Module Information..." in order to perform a hardware 

diagnosis. 

 
Figure 8-1 Module status 
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8.2 General diagnostics 

Diagnostic interrupt tab 
On the Diagnostic Interrupt tab you will find information for the reported error. 
The interrupts are not channel dependent and apply to the entire module. 

 
Figure 8-2 Diagnostics for SM331 
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8.3 Channel dependent diagnostic messages 

Channel dependent diagnostic messages 
There are five channel dependent diagnostic messages: 
● Configuration/programming error 
● Common mode error 
● Wire break 
● Underflow 
● Overflow 

 

  Note 
Here we show you only the channel specific diagnostics for the measuring modes 2 or 4-
wire current transducers. Other measuring modes are similar and are not described here.

 

Configuration/programming error 
The position of the measuring range modules does not match the measuring mode set in the 
hardware configuration. 

Common mode error 
The voltage difference Ucm between the inputs (M-) and the common voltage potential of the 
measuring circuit (Mana) is too high. 
In our example, this error cannot occur because Mana is connected to M for a 2-wire 
transducer. 
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Wire break 
For all thermocouple types you can detect a wire break in the diagnostics. 

 
Figure 8-3 Left: Diagnostic message with wire break/Right: Variable table 

The analog-value representation shows an overflow (HEX 7FFF). 

Underflow 
The thermocouples can trigger the diagnostic message "Analog input measuring range/low 
limit undershot". 
If you install the wrong thermocouple type you can also create an underflow. 
In our example, we have simulated a thermocouple type E with a thermocouple simulator (to 
-454.00°F). At -454.01°F we get an underflow of the measuring range. 

1

 
Figure 8-4 Left: Diagnostic message with underflow/Right: Variable table 

 
(1) Display -454.01°F at the thermocouple simulator 
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Overflow 
The thermocouples can trigger the diagnostic message "Analog input measuring range/high 
limit exceeded". 
In our example, we have simulated a thermocouple type B with a thermocouple simulator (to 
+3,092.00°F). At 2642.01°F we get an overflow of the measuring range. 

1

 
Figure 8-5 Left: Diagnostic message with overflow/Right: Variable table 

 
(1) Display 2642.01°F at the thermocouple simulator 
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Hardware interrupt 9
9.1 Hardware interrupt 

Overview 
A special feature of the SM331 AI8x12bit is its capability to also trigger hardware interrupts. 
Two channels (0 and 2) can be correspondingly configured. 
The limits of the hardware interrupts must be specified for the thermocouples in °C (not in °F 
or K). 

Properties of the hardware interrupt trigger 
In order to trigger a hardware interrupt, the limit values have to be within the nominal values 
of the measuring mode. 
Example 
Let us assume that you are using a thermocouple type J with a nominal range of -210.0°C 
and 1450.0°C. When you enter the low limit of -250°C, the setting is accepted by the system 
but the hardware interrupt is not triggered because the diagnostic interrupt (underflow of the 
nominal range) is always triggered first. 
In our example, channel 0 (thermocouple type J) is configured with the following limits: 
● Lower limit value -50 °C 
● Upper limit value +500 °C 
If these values exceed or fall below the nominal range, hardware interrupt OB40 will be 
triggered. 
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Hardware interrupt OB40 
Hardware interrupts generally trigger alarm organization blocks in the CPU. In our example, 
OB40 is called. 
In the STEP7 program, OB40 is used for hardware interrupts. Depending on the CPU, more 
hardware interrupts can be configured. 
If a hardware interrupt occurs, OB40 is called. In the user program of OB40 you can program 
the reaction of the automation system to hardware interrupts. 
In the example user program, OB40 reads the cause of the hardware interrupt. This can be 
found in the temporary variable structure OB40_POINT_ADDR (local bytes 8 to 11). 

1

2

 
Figure 9-1 OB40 start information: Which event has violated limits and triggered a hardware 

interrupt 

 
(1) Violation of the low limit at channel 0 
(2) Violation of the low limit at channel 1 
(3) Violation of the high limit at channel 0 
(4) Violation of the high limit at channel 1 

In the example, OB40 only transfers the LB8 and LB9 local data variables into a marker word 
(MW100). The marker word is monitored in the existing variable table. 
You can acknowledge the marker word in OB1 by setting marker bit M200.0 or by setting it 
to "TRUE" in the variable table. 
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Simulation of a hardware interrupt 
When you heat a thermocouple type J with a lighter, in the variable table in MW100 you will 
get the binary value 0000 0001 0000 0000. That means the OB40 was called and channel 0 
had an overflow of the high limit >500°C. 

 
Figure 9-2 Process interrupt: Low limit undershot at channel 0 
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Appendix A
A.1 Source code of the user program 

Overview 
This chapter provides a quick overview of the functions associated with the example station's 
user program. A flowchart shows the general program structure and in the STL source code 
you will find the complete program in detail. 
You can download the STL source code file for your own application directly from the HTML 
page from which you loaded this "Getting Started". 

Flowchart 
The red text corresponds to the source code in the user program. 

 
Figure A-1 OB1 flowchart 
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Variable description 
 

Variables Description 
DB1.DBW 0 Channel 0 Display of analog value 
DB1.DBW 2 Channel 1 Display of analog value 
DB1.DBW 4 Channel 2 Display of analog value 
DB1.DBW 6 Channel 3 Display of analog value 
DB1.DBW 8 Channel 4 Display of analog value 
DB1.DBW 10 Channel 5 Display of analog value 
DB1.DBW 12 Channel 6 Display of analog value 
DB1.DBW 14 Channel 7 Display of analog value 
DB2.DBD 0 Thermocouple (°C)  
DB2.DBD 4 Thermocouple (°C)  
DB2.DBD 8 Thermocouple (°C)  
DB2.DBD 12 Thermocouple (°C)  
M200.0 Acknowledge hardware interrupt 
MW 100 Status hardware interrupt 

STL source code 
 
DATA_BLOCK DB 1 
TITLE = 
VERSION : 0.1 
   
 STRUCT  
  CH_0 : INT; //Channel 0 

  CH_1 : INT; //Channel 1 

  CH_2 : INT; //Channel 2 

  CH_3 : INT; //Channel 3 

  CH_4 : INT; //Channel 4 

  CH_5 : INT; //Channel 5 

  CH_6 : INT; //Channel 6 

  CH_7 : INT; //Channel 7 

 END_STRUCT ;   
BEGIN 
  CH_0 := 0;  
  CH_1 := 0;  
  CH_2 := 0;  
  CH_3 := 0;  
  CH_4 := 0;  
  CH_5 := 0;  
  CH_6 := 0;  
  CH_7 := 0;  
END_DATA_BLOCK 
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DATA_BLOCK DB 2 
TITLE = 
VERSION : 0.1 
   
 STRUCT  
  SE_1 : REAL ; // Temperature 

  SE_2 : REAL ; // Temperature 

  SE_3 : REAL ; // Not used 

  SE_4 : REAL ; // Not used 

 END_STRUCT ;  
BEGIN 
  SE_1 := 0.000000e+000;  
  SE_2 := 0.000000e+000;  
  SE_3 := 0.000000e+000;  
  SE_4 := 0.000000e+000;  
END_DATA_BLOCK 
 
FUNCTION FC 1 : VOID 
TITLE = 
VERSION : 0.1 
 
VAR_INPUT 
 RawValue : INT;  
 Factor : REAL ;  
 Offset : REAL ;  
 OverFlow : INT;  
 OverRange : INT;  
 UnderRange : INT;  
 UnderFlow : INT;  
END_VAR 
VAR_OUTPUT 
 MeasuredValue : REAL ;  
 Status: WORD ;  
END_VAR 
VAR_TEMP 
 TInt : INT;    
 TDoubleInt : DINT ;    
 TFactor : REAL ;    
 TOffset : REAL ;    
 TFactor1 : DINT ;    
 TFactor2 : REAL ;    
END_VAR 
BEGIN 
NETWORK 
TITLE = Conversion 
     L #RawValue;   
     ITD ;   
     DTR ;   
     L #Factor;   
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     *R ;   
     L #Offset;   
     +R ;   
     M #MeasuredValue;   
 
 
NETWORK 
TITLE =Analog-value representation monitoring 
     L W#16#0;   
     M #Status;   
         
     L #RawValue;   
     L #OverFlow;   
     >=I ;   
     JC m_of;   
         
     L #RawValue;   
     L #OverRange;   
     >=I ;   
     JC m_or;   
         
     L #RawValue;   
     L #UnderFlow;   
     <=I ;   
     JC m_uf;   
         
     L #RawValue;   
     L #UnderRange;   
     <=I ;   
     JC m_ur;   
         
     JL end;   
     
m_of: L W#16#800;   
     M #Status;   
     JL end;   
     
m_or: L W#16#400;   
     M #Status;   
     JL end;   
     
m_uf: L W#16#200;   
     M #Status;   
     JL end;   
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m_ur: L W#16#100;   
     M #Status;   
     JL end;   
     
     
end:  NOP 0;   
 
 
END_FUNCTION 
 
ORGANIZATION_BLOCK OB 1 
TITLE = "Main Program Sweep (Cycle)" 
VERSION : 0.1 
 
VAR_TEMP 

 
 
 OB1_EV_CLASS : BYTE ; //Bits 0-3 = 1 (Coming event), Bits 4-7 = 1 (Event 

class 1) 
 OB1_SCAN_1 : BYTE ; //1 (Cold restart scan 1 of OB 1), 3 (Scan 2-n of 

OB 1) 
 OB1_PRIORITY : BYTE ; //Priority of OB Execution 

 OB1_OB_NUMBR : BYTE ; //1 (Organization block 1, OB1) 

 OB1_RESERVED_1 : BYTE ; //Reserved for system 

 OB1_RESERVED_2 : BYTE ; //Reserved for system 

 OB1_PREV_CYCLE : INT; //Cycle time of previous OB1 scan (milliseconds) 

 OB1_MIN_CYCLE : INT; //Minimum cycle time of OB1 (milliseconds) 

 OB1_MAX_CYCLE : INT; //Minimum cycle time of OB1 (milliseconds) 

 OB1_DATE_TIME : DATE_AND_TIME ; //Date and time OB1 started 

 
 
END_VAR 
BEGIN 
NETWORK 
TITLE =Transfer channel values to data block DB 1 
// Channel 0 -> Data block 
     L PEW 256;   
     M DB1.DBW  0;  
 
// Channel 1 -> Data block 
     L PEW 258;   
     M DB1.DBW  2;  
 
// Channel 2 -> Data block 
     L PEW 260;   
     M DB1.DBW  4;  
 
// Channel 3 -> Data block 
     L PEW 262;   
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     M DB1.DBW  6;  
 
// Channel 4 -> Data block 
     L PEW 264;   
     M DB1.DBW  8;  
 
// Channel 5 -> Data block 
     L PEW 266;   
     M DB1.DBW  10;  
 
// Channel 6 -> Data block 
     L PEW 268;   
     M DB1.DBW  12;  
 
// Channel 7 -> Data block 
     L PEW 270;   
     M DB1.DBW  14;  
 
 
NETWORK 
TITLE =Conversion of analog-value representation -> Measurement value 
// Channel 1 : Thermocouple type J 
     CALL FC 1(   
      RawValue := DB1.DBW  0, 

      Factor := 1.000000e-001,  
      Offset := 0.000000e+000,  
      OverFlow := 14501,  
      OverRange := 12010,  
      UnderRange := -2101,  
      UnderFlow := -2101,  
      MeasuredValue := DB2.DBD  0, 

      Status := MW  10); 

 
// Channel 2 : Thermocouple type J 
         
     CALL FC  1 (   
      RawValue := DB1.DBW  2, 

      Factor := 1.000000e-001,  
      Offset := 0.000000e+000,  
      OverFlow := 14501,  
      OverRange := 12010,  
      UnderRange := -2101,  
      UnderFlow := -2101,  
      MeasuredValue := DB2.DBD 4,  
      Status := MW 20);  
 
// Channel 3 : Thermocouple type K 
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     CALL FC  1 (   
      RawValue := DB1.DBW 4,  
      Factor := 1.000000e-001,  
      Offset := 0.000000e+000,  
      OverFlow := 16221,  
      OverRange := 13730,  
      UnderRange := -2701,  
      UnderFlow := -2701,  
      MeasuredValue := DB2.DBD 8,  
      Status := MW 30);  
 
// Channel 4 : Thermocouple type K 
         
     CALL FC  1 (   
      RawValue := DB1.DBW 6,  
      Factor := 1.000000e-001,  
      Offset := 0.000000e+000,  
      OverFlow := 16221,  
      OverRange := 13730,  
      UnderRange := -2701,  
      UnderFlow := -2701,  
      MeasuredValue := DB2.DBD 12,  
      Status := MW 40);  
 
NETWORK 
TITLE =Acknowledge hardware interrupt 
     U M 200.0;  
     EP M 200.1;  
     SPBN m001;   
     L 0;   
     M FD 100;  
     M FW 104;  
     M FW 106;  
     R M 200.0;  
m001: NOP 0;   
 
END_ORGANIZATION_BLOCK 
 
ORGANIZATION_BLOCK OB 40 
TITLE = "Hardware Interrupt" 
VERSION : 0.1 
 
VAR_TEMP 
 OB40_EV_CLASS : BYTE ; //Bits 0-3 = 1 (Coming event), Bits 4-7 = 1 (Event 

class 1) 
 OB40_STRT_INF : BYTE ; //16#41 (OB 40 has started) 

 OB40_PRIORITY : BYTE ; //Priority of OB Execution 
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 OB40_OB_NUMBR : BYTE ; //40 (Organization block 40, OB40) 

  OB40_RESERVED_1 : BYTE ; //Reserved for system 

 OB40_IO_FLAG : BYTE ; //16#54 (input module), 16#55 (output module) 

 OB40_MDL_ADDR : WORD ; //Base address of module initiating interrupt 

 OB40_POINT_ADDR : DWORD ; //Interrupt status of the module 

 OB40_DATE_TIME : DATE_AND_TIME ; //Date and time OB40 started  
END_VAR 
BEGIN 
NETWORK 
TITLE = 
     L #OB40_IO_FLAG; //OB40_IO_FLAG  : 16#54=Input module 

     M MB 104; //  : 16#55=Output module 

     L #OB40_MDL_ADDR; //OB40_MDL_ADDR  : Base address of 

     M FW 106; //  module initiating interrupt 

     L #OB40_POINT_ADDR; //OB40_POINT_ADDR  : LB8 = Exceeding 

     M FD 100; //  high limit 

     NO
P 

0; //OB40_POINT_ADDR  : LB9 = Underflow of 

     NO
P 

0; //  low limit 

 
 
END_ORGANIZATION_BLOCK 
 
ORGANIZATION_BLOCK OB 82 
TITLE = "I/O Point Fault" 
VERSION : 0.1 
   
VAR_TEMP 
 OB82_EV_CLASS : BYTE ; //16#39, Event class 3, Entering event state, 

Internal fault event 
 OB82_FLT_ID : BYTE ; //16#XX, Fault identification code 

 OB82_PRIORITY : BYTE ; //Priority of OB Execution 

 OB82_OB_NUMBR : BYTE ; //82 (Organization block 82, OB82) 

 OB82_RESERVED_1 : BYTE ; //Reserved for system 

 OB82_IO_FLAG : BYTE ; //Input (01010100), Output (01010101) 

 OB82_MDL_ADDR : WORD ; //Base address of module with fault 

 OB82_MDL_DEFECT : BOOL; //Module defective 

 OB82_INT_FAULT : BOOL; //Internal fault 

 OB82_EXT_FAULT : BOOL; //External fault 

 OB82_PNT_INFO : BOOL; //Point information 

 OB82_EXT_VOLTAGE : BOOL; //External voltage low 

 OB82_FLD_CONNCTR : BOOL; //Field wiring connector missing 

 OB82_NO_CONFIG : BOOL; //Module has no configuration data 

 OB82_CONFIG_ERR : BOOL; //Module has configuration error 

 OB82_MDL_TYPE : BYTE ; //Type of module 

 OB82_SUB_MDL_ERR : BOOL; //Sub-Module is missing or has error 

 OB82_COMM_FAULT : BOOL; //Communication fault 

 OB82_MDL_STOP : BOOL; //Module is stopped 

 OB82_WTCH_DOG_FLT : BOOL; //Watch dog timer stopped module 
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 OB82_INT_PS_FLT : BOOL; //Internal power supply fault 

 OB82_PRIM_BATT_FLT : BOOL; //Primary battery is in fault 

 OB82_BCKUP_BATT_FLT : BOOL; //Backup battery is in fault 

 OB82_RESERVED_2 : BOOL; //Reserved for system 

 OB82_RACK_FLT : BOOL; //Rack fault, only for bus interface module 

 OB82_PROC_FLT : BOOL; //Processor fault 

 OB82_EPROM_FLT : BOOL; //EPROM fault 

 OB82_RAM_FLT : BOOL; //RAM fault 

 OB82_ADU_FLT : BOOL; //ADC fault 

 OB82_FUSE_FLT : BOOL; //Fuse fault 

 OB82_HW_INTR_FLT : BOOL; //Hardware interrupt input in fault 

 OB82_RESERVED_3 : BOOL; //Reserved for system  

 OB82_DATE_TIME : DATE_AND_TIME ; //Date and time OB82 started  
END_VAR 
BEGIN 
END_ORGANIZATION_BLOCK 

 

See also 
Creating a user program (Page 6-19) 
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